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Abstrakt 

 Táto diplomová práca sa zaoberá mapovaním a vytvorením banskej mapovej 

dokumentácie štôlne Josef v oblasti Mokrsko Západ. Na začiatku bolo nutné urobiť 

zameranie oblasti pomocou laserového skeneru – Leica ScanStation P40. Výstupom 

z merania bolo mračno bodov, ktoré sa spracovalo v softvéri Leica Cyclone. Výsledné 

mapové diela štôlne boli vytvorené v softvéri MicroStation s nadstavbou DULMAP.  

 

 

Kľúčové slová 

štôlňa Josef, Mokrsko Západ, laserové skenovanie, mračno bodov, 3D model, Leica 

Cyclone, Microstation, DULMAP 

 

 

 

Abstract 

 This diploma thesis deals with the mapping and creation of mining map 

documentation of the Josef mine in the Mokrsko Západ area. Initially, it was necessary to 

measure the area using a laser scanner – Leica ScanStation P40. The output of the 

measurement was a point cloud, which was processed in Leica Cyclone software. The 

resulting map works of the mine were created in MicroStation software with the 

DULMAP extension. 

 

 

Keywords 

Josef mine, Mokrsko Západ, laser scanning, point cloud, 3D model, Leica Cyclone, 

Microstation, DULMAP 
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1 Úvod 

 Táto diplomová práca sa zaoberá mapovaním štôlne Josef v oblasti Mokrsko 

Západ. Jej hlavným cieľom je zameranie podzemného objektu metódou 3D laserového 

skenovania, následné spracovanie získaných dát a vyhotovenie príslušnej banskej 

mapovej dokumentácie. 

 Štôlňa Josef je externé pracovisko Fakulty Stavební na ČVUT v Praze, ktoré slúži 

k praktickému vzdelávaniu študentov a k realizácii výskumných projektov, ktoré sú 

zamerané hlavne na budovanie podzemného úložiska rádioaktívnych odpadov. Celý areál 

štôlne sa skladá s Podzemného laboratória Josef a Regionálneho podzemného 

výskumného centra URC Josef. Podzemné laboratórium Josef je rozdelené na oblasti 

Čelina a Mokrsko podľa dedín, pod ktorými sa štôlňa nachádza. Objektom mapovania 

bola vybratá oblasť Mokrska Západ práve z dôvodu, že v tejto oblasti ešte neprebiehalo 

žiadne meranie metódou 3D laserového skenovania.  

 Meranie podzemných priestorov pomocou tejto metódy prináša veľa výhod oproti 

klasickým geodetickým metódam. Proces merania je plne automatický a v relatívne 

krátkom čase je možné získať komplexné zameranie aj veľmi členitých objektov. Pre 

následné spracovanie dát a vyhotovenie banskej mapovej dokumentácie je nutné použiť 

špecializovaný softvér. K tomuto účelu sa použije softvér DULMAP, ktorý slúži pre 

vytváranie banských máp v súlade s vyhláškou č. 435/1992 Sb.  

 Vo výslednej mapovej dokumentácii sa musí zachovať jednotný spôsob značenia 

prvkov ako v existujúcich mapách štôlne. V tomto smere bude táto práca nadväzovať na 

diplomovú prácu Ing. Ladislava Ritschela z roku 2020, v ktorej sa nachádza celá mapová 

dokumentácia v oblasti Čelina.  

 Celá diplomová práca je rozdelená do siedmych kapitol. Úvodná kapitola sa 

venuje popisu a histórií štôlne Josef. Takisto je v nej spomenutá lokalita a využitie tohto 

podzemného pracoviska v súčasnosti. Ďalej sa v práci nachádza princíp merania štôlne, 

technológie a popis prístroja, ktorým boli získavané dáta. V ďalšej kapitole je zase 

uvedený popis použitých softvérov a postup spracovania dát. Záver práce je venovaný 

popisu mapových diel, ktoré sú výsledkom tejto diplomovej práce. 
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2 Štôlňa Josef 

  Štôlňa Josef je historické banské dielo, ktoré bolo vybudované v rokoch 1981 až 

1991 za účelom geologického prieskumu zlatonosných ložísk v revíri Psí hory. 

V súčasnosti je štôlňa Josef pod správou Centra experimentálnej geotechniky (CEG), 

ktoré je výskumným pracoviskom Fakulty Stavební univerzity ČVUT v Praze. 

 Na začiatku 80. rokov 20. storočia začal prebiehať podrobný geologický prieskum 

v revíri Psí hory, ktorého cieľom bolo zhodnotenie zásob zlata v podzemných ložiskách. 

V rámci prieskumu bolo vyhĺbených množstvo geologických vrtov a taktiež bola 

vybudovaná nová štôlňa Josef. Celkové zásoby v oblasti boli odhadnuté na 130 ton zlata, 

čo je viac než sa vyťažilo na celom území Českej republiky v priebehu celej histórie 

dobývania zlata. Napriek tomu nikdy nedošlo k priemyselnej ťažbe z dôvodu obáv, že by 

ťažba mohla mať zničujúci vplyv na životné prostredie. Po skončení geologického 

prieskumu bola štôlňa na niekoľko rokov uzatvorená. K obnoveniu činnosti došlo až 

v roku 2007 otvorením Podzemného laboratória Josef v priestoroch štôlne, ktoré 

v súčasnosti slúži k praktickej výuke študentov a k realizácií výskumných projektov. 

Následne v roku 2011 bolo otvorené Regionálne podzemné výskumné centrum URC 

Josef na mieste bývalej šachtovej budovy v povrchovom areáli štôlne, ktorá bola 

dlhodobo nevyužívaná. URC Josef je vedecko-technický park, ktorý slúži ako zázemie 

pre prácu a výskum v podzemných priestoroch. Jeho hlavným cieľom je technologický 

vývoj, ktorý sa hlavne zameriava na podzemné stavby. V súčasnosti je štôlňa Josef 

otvorená nielen pre zamestnancov výskumného centra, ale aj pre laickú verejnosť. [1] 

Obr. 1 Pohľad na areál štôlne Josef [2] 
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2.1 História ťažby zlata v revíri Psí hory 

 Zlatonosný revír Psí hory sa nachádza v blízkosti banského mesta Nový Knín. 

V jeho okolí sa nachádzajú ešte ďalšie tri revíry, kde sa v minulosti ťažilo zlato: 

novoknínský, kozohorský a libčický revír. Najdôležitejším zo všetkých spomenutých 

revírov bol práve libčický, kde sa zlato ťažilo s prestávkami od stredoveku až do prvej 

polovice 20. storočia. Oblasť Psí hory je ako jediná z historických zlatonosných oblastí 

Nového Knína, ktorá je situovaná v horninách jílovského pásma pomenovaného podľa 

mesta Jílové u Prahy. Práve zlato dobývané v okolí mesta Jílové zohralo významnú úlohu 

v českej histórii. Slúžilo ako hlavná surovina pre razenie luxemburských dukátov, ktoré 

zaviedol v roku 1325 ako prvý panovník v strednej Európe Ján Luxemburský. Ťažba 

v tejto oblasti prebiehala v rôznych intenzitách aj v neskorších obdobiach. K jej zrejme 

definitívnemu ukončeniu došlo až v roku 1968. 

 Písomných záznamov o histórii dobývania zlata v revíri Psí hory existuje len 

veľmi málo. Napriek tomu sa na mnohých miestach v revíri dochovali pozostatky banskej 

činnosti. Niektoré z nich sú dodnes viditeľné priamo v teréne.  

 Ťažba zlata na českom území zaznamenala prvý veľký rozkvet až v keltskom 

období, hlavne v 2. a 1. storočí pred Kristom. Kelti drvivú väčšinu svojho zlata získavali 

z ryžovísk. Po odchode Keltov zostali miestne ložiská dlho nevyužité. Hlavný rozvoj 

ťažby zlata v revíri Psí hory priniesol až stredovek. Na prelome 13. a 14. storočia sa 

prvýkrát začalo s dolovaním. Najväčší rozmach dosiahla ťažba v priebehu 14. storočia. 

V tej dobe sa zlato dobývalo z kremenných žíl na mnohých miestach revíru pomocou 

štôlní a šachiet. Podzemné diela dosahovali priemernej hĺbky okolo 20 metrov, najväčšia 

dosiahnutá hĺbka bola 60 metrov pod povrchom. V blízkosti najväčšej šachty existovala 

aj kováčska vyhňa na výrobu baníckeho náradia a na Čelinskom potoku bolo v prevádzke 

niekoľko mlynov na drvenie rudy. Stredovekí baníci používali pri svojej práci veľmi 

jednoduché vybavenie. V baniach si svietili hlinenými kahanmi, ktoré boli naplnené 

lojom. Rudu ťažili železnými kladivkami, ktoré sa veľmi rýchlo opotrebovávali. Jeden 

baník ich za jednu zmenu spotreboval viac než dvadsať. Vyťaženú rudu prepravovali do 

rudných mlynov, kde sa drvila a mlela. Zlato sa potom z rozomletej rudy oddeľovalo 

amalgamáciou. 
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 Obdobie najväčšieho rozkvetu ťažby skončilo na prelome 14. a 15. storočia. 

Príčinou úpadku boli rastúce prevádzkové náklady, vyčerpanie prístupnejších častí 

zlatonosných kremenných žíl, technické problémy pri dolovaní vo väčších hĺbkach a tiež 

búrlivá politická situácia v zemi. Dobývanie zlata tak bolo na niekoľko desaťročí 

prerušené. K obnove baní došlo na prelome 15. a 16. storočia. Druhá etapa ťažby zlata 

však trvala len krátko a nebola zďaleka taká významná. K jej úplnému ukončeniu došlo 

približne v polovici 16. storočia. [1] 

 

2.1.1 Revír Psí hory v 20. storočí 

 Zlatonosný revír Psí hory zostal nevyužitý a neskúmaný od 16. storočia takmer až 

do konce 20. storočia. V rokoch 1977 až 1980 v tejto oblasti prebehol rozsiahly 

regionálny revízny prieskum hornín jílovského pásma, ktorý odhalil možnú prítomnosť 

významného zlatonosného ložiska. V rokoch 1980 až 1990 potom prebehol podrobný 

prieskum oblasti Psí hory. Jeho súčasťou bolo geologické mapovanie, geofyzikálny 

prieskum, podrobný geochemický prieskum pôdneho pokryvu, prieskum pomocou vrtov 

z povrchu do hĺbky 300 až 600 metrov a taktiež aj banský prieskum z vyrazenej štôlne 

Josef, kombinovaný s podzemnými vrty. Výsledkom prieskumu bolo zhodnotenie zásob 

zlata na dosiaľ známych ložiskách Čelina a Mokrsko Východ a predovšetkým objavenie 

nového ložiska Mokrsko Západ, ktorého využiteľné zásoby boli odhadnuté na 75 ton 

zlata. Toto ložisko tak v súčasnosti patrí medzi najbohatšie ložiská zlata v Európe. 

Celkový potenciál všetkých ložísk revíru bol odhadnutý na 130 ton zlata.  

 V rámci prieskumu prebiehala v rokoch 1989 až 1991 aj experimentálna 

podzemná ťažba ložiska Čelina. Bolo vyťažených celkom 19 500 ton zeminy, z ktorej sa 

získalo 21,5 kg zlata. Napriek tomu nikdy nedošlo k priemyslovému využitiu revíru kvôli 

predpokladanému negatívnemu vplyvu prípadnej ťažby na životné prostredie. Ložisko 

Mokrsko Západ, ktoré je hlavným zdrojom zlata, by sa totiž muselo dobývať výhradne 

povrchovým spôsobom, čo by nezvratne zasiahlo do okolitej krajiny. Pre jeho separáciu 

by bolo nutné použiť ekologicky riskantnú metódu kyanidového lúhovania. Od polovice 

90. rokov, po ukončení všetkých prieskumných činností, štôlňa a jej okolie postupne 

chátrali. V roku 2000 bol stav areálu už natoľko neuspokojivý, že bolo z bezpečnostných 

dôvodov pristúpené k zabetónovaniu prístupových portálov do štôlne. [1] 
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2.2 Lokalita 

 Štôlňa Josef sa nachádza v blízkom okolí vodnej nádrže Slapy približne 50 km 

južne od Prahy. Leží v katastrálnom území Prostřední Lhoty, miestnej časti obce 

Chotilsko v okrese Příbram v Stredočeskom kraji (Obr. 2).  

Obr. 2 Ortofotomapa s polohou štôlne Josef [5] [7] 
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2.3 Popis rozdelenia štôlne 

 Podzemné priestory štôlne Josef sa delia na oblasti Čelina a Mokrsko podľa dedín, 

pod ktorými sa nachádzajú. Každá z týchto oblastí sa delí na západnú a východnú podľa 

toho, ako sú situované od prepojovacej chodby. Prepojovacia chodba je najdlhším 

líniovým úsekom v štôlni Josef a prepája všetky spomenuté oblasti. Začína vstupom do 

štôlne a prechádza horninovým masívom Veselého vrchu smerom na SSZ. Na jej konci 

sa nachádza vetrací komín, ktorý je vysoký 136 metrov a je spojený s povrchom terénu. 

Prevažná väčšina chodieb v štôlni (okolo 90 %) nie je ničím vystužená. V oblasti Čelina 

Východ je štôlňa napojená do dvoch ďalších poschodí, ktoré sa nachádzajú vo výškových 

úrovniach 20 a 40 metrov nad základným poschodím. Presne v tejto časti sa nachádza aj 

podzemná skalná katedrála, ktorá prepája všetky tri poschodia. V oblastiach Čelina Západ 

a Mokrsko Západ sa v súčasnosti realizuje množstvo vedeckých projektov, na ktorých sa 

podieľa niekoľko vysokých škôl. Posledná oblasť Mokrsko Východ je na rozdiel od 

ostatných z veľkej časti neprístupná. Predmetom mapovania v tejto diplomovej práci je 

oblasť západného Mokrska spolu s malou časťou východného Mokrska (Obr. 3). [1] 

Obr. 3 Mapa štôlne Josef [4] [5] 
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Technické parametre štôlne: 

 Celková dĺžka chodieb:   7853 m 

 Dĺžka prepojovacej chodby:  1835 m Profil:  14 – 16 m2 

 Dĺžka ostatných chodieb:   6018 m Profil:  9 m2 

 Dĺžka mapovaných chodieb:  1050 m 

 Výška nadložia:   90 – 150 m [1] 

 

2.4 Mokrsko Západ 

 Oblasť Mokrsko Západ (Obr. 4) je miestom realizácie niekoľkých výskumných 

projektov a experimentov. V roku 2010 vzniklo v priestoroch štôlne Medziuniverzitné 

podzemné laboratórium MeziLab, ktoré slúži na spoluprácu medzi vysokými školami pri 

vzdelávaní odborníkov v oblasti budovania hlbinného úložiska a prevádzky podzemných 

zásobníkov plynu. Je to centralizovaný rozvojový projekt, na ktorom sa podieľali 

univerzity ČVUT v Praze, MU v Brne, TU v Liberci a VŠCHT v Praze. V roku 2014 

vznikol podobný projekt MeziLab II, ktorého účel je in situ výuka transportných procesov 

v reálnom horninovom prostredí. Toto podzemné laboratórium takisto slúži študentom 

k zberu dát na vypracovanie ich záverečných prác. V západnom Mokrsku sú situované aj 

ďalšie vedecké projekty ako napr.: 

 DOPAS – Medzinárodný európsky projekt, ktorého cieľom je v reálnom meradle 

vybudovať v rôznych geologických podmienkach štyri experimentálne zátky 

určené pre konštrukciu hlbinného úložiska. [3] 

 

 Mock - Up Josef – Prvý fyzikálny model v Českej republike simulujúci vertikálne 

uloženie kontajneru s vyhoretým jadrovým palivom v úložnej studni. [3] 

 

 Viacgeneračné neaktívne stopovače – Cieľom projektu je vývoj a overenie 

funkčnosti série ľahko identifikovateľných stopovačov s rovnakým fyzikálnym 

správaním, ktoré priechodom pukliny zostanú fixované na povrchu. [3] 

 

 Inžinierska bariéra 200C – Cieľom projektu je zvýšiť bezpečnosť a znížiť 

finančnú náročnosť výstavby hlbinného úložiska rádioaktívnych odpadov. [6] 
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2.4.1 Mapa projektov v podzemných priestoroch 

Obr. 4 Mapa projektov v oblasti Mokrsko Západ [6] 

 

Vysvetlivky: 

1. Záchranná komora 

2. Vetrací komín 

3. Nádrž s technickou vodou 

4. Anaeróbne laboratórium 

5. Technologické centrum DOPASu 

6. Projekt DOPAS 

7. Mock-Up Josef experiment 

8. Medziuniverzitné podzemné laboratórium (MeziLab)  

9. Medziuniverzitné podzemné laboratórium (MeziLab II) 

10. Projekt „Viacgeneračného stopovača“ 

11. Inžinierska bariéra 200C 

 

 Všetky projekty uvedené v tejto kapitole boli prebraté z výročnej správy 

vedeckého pracoviska URC Josef za rok 2019. [6] 



 
 

16 
 

3 Technológia 3D laserového skenovania  

 Technológia 3D laserového skenovania je relatívne novou exaktnou metódou pre 

zber informácií o objektoch. Jedná sa o automatickú, bezkontaktnú a neselektívnu metódu 

získavania priestorových súradníc, ktorou je možné dokumentovať rýchlo a jednoducho 

zložité komplexy budov. Z toho dôvodu je často využívaná pri dokumentácií historických 

pamiatok a priestorov, ktoré sú ťažko prístupné ako napríklad klenby kostolov, krovy, 

jaskyne a banské diela.  

 Metóda 3D laserového skenovania má viacero výhod v porovnaní s klasickými 

geodetickými metódami. V relatívne krátkom čase je možné získať komplexné a presné 

zameranie objektu. Meranie v teréne je plne automatizovaný proces, ktorý prebieha na 

základe nastavených parametrov skenovacieho systému. Medzi nastaviteľné parametre 

patrí zorné pole skenovania, hustota bodov a presnosť určovania polohy bodov. 

Výsledkom merania je mračno bodov, ktoré môže slúžiť pre tvorbu 3D modelov a ich 

vizualizácií.  

 Spracovanie nameraných dát v podobe mračna bodov si vyžaduje častokrát viac 

úsilia a času ako samotné meranie v teréne. Veľkosť mračna bodov sa môže pohybovať 

v rádoch miliónoch až miliárd bodov. Na spracovanie takého veľkého množstva dát je 

potrebný špeciálny softvér a vysoký výpočtový výkon hardvéru. Mračno bodov sa musí 

opraviť od rôznych chýb, ktoré vznikli počas merania. V prípade rozsiahlych objektov je 

nutné urobiť skenovanie z viacerých stanovísk. Výsledkom merania je v tom prípade 

niekoľko mračien bodov, ktoré sa nenachádzajú v tej istej súradnicovej sústave. Z toho 

dôvodu sa musia transformovať do jednej sústavy pomocou vlícovacích (identických) 

bodov. Ako vlícovacie body je možné použiť body na objekte, ktoré sa dajú ľahko 

identifikovať a zároveň sa nachádzajú v susedných mračnách bodov. Na transformáciu sa 

dajú použiť aj guľové alebo čiernobiele terče. Spojené a upravené mračno bodov sa môže 

ďalej spracovávať spôsobom aproximácie objektov základnými geometrickými prvkami. 

Napríklad stenu je možné nahradiť rovinou a stĺp valcom. Ďalším spôsobom spracovania 

je generovanie trojuholníkovej siete z jednotlivých bodov mračna. V prípade tejto 

diplomovej práce bolo mračno bodov vektorizované a pomocou líniových prvkov bol 

vytvorený pôdorys a priečne rezy podzemných priestorov. [9] 
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3.1 Princíp 3D laserového skenovania 

 Meranie 3D laserovým skenovacím systémom sa zakladá na princípe vysielania 

(emitovania) laserového lúču od prístroja smerom k objektu, kde sa lúč odrazí a putuje 

spať k prístroju. Týmto spôsobom je možné určiť priamu vzdialenosť medzi prístrojom a 

bodom, v ktorom sa lúč odrazil od objektu. Zariadenie, ktoré vykonáva túto funkciu sa 

nazýva elektronický diaľkomer a je zabudované priamo v prístroji. Existujú dva typy 

elektronických diaľkomerov: impulzný a fázový. Viac o nich je spomenuté v podkapitole 

o rozdelení skenovacích systémov. Pri tomto procese sa zaznamenáva aj horizontálny 

a vertikálny uhol, pod ktorým bol laserový lúč vyslaný z prístroja. Na základe meranej 

vzdialenosti a uhlov je možné vypočítať priestorové súradnice určovaného bodu pomocou 

priestorovej polárnej metódy. Skenovacie prístroje, ktoré používajú túto metódu výpočtu 

sa nazývajú polárne skenery.  

 Celý proces určenia súradníc dokáže prístroj opakovať až miliónkrát za sekundu. 

Súčasne sa počas toho otáča v dvoch na seba kolmých rovinách, aby zachytil všetky body 

objektu v pravidelnom rastre (Obr. 5).  

 

 

Obr. 5 Schéma merania skenovacím systémom [10] 
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3.2 Priestorová polárna metóda 

 V súčasnosti je priestorová polárna metóda (Obr. 6) jednou z najpoužívanejších 

metód určovania súradníc v obore geodézie. Je to z dôvodu, že je jednoduchá na výpočet 

a pri meraní časovo nenáročná. Používa sa nielen v skenovacích prístrojoch, ale aj 

v totálnych staniciach a v laserových trackeroch, ktoré sa využívajú hlavne v strojníctve. 

Môže sa tiež označovať ako digitálna tachymetria. 

 Pomocou priestorovej polárnej metódy je možné vypočítať pravouhlé priestorové 

súradnice určovaného bodu (x, y, z) na základe troch matematických vzorcov. Meranými 

veličinami, ktoré vstupujú do vzorcov, sú šikmá dĺžka d, horizontálny uhol ω a vertikálny 

uhol ζ. Taktiež do výpočtu vstupujú aj súradnice stanoviska (x0, y0, z0), na ktorom sa 

prístroj nachádza. V prípade polárnych skenerov sa stanovisko prístroja nachádza 

v počiatku pravouhlej súradnicovej sústavy a z toho dôvodu sú súradnice nulové.  

 

Vzorce pre výpočet pravouhlých súradníc:  

 x = x0 + d . sin(ζ) . cos(ω) 

 y = y0 + d . sin(ζ) . sin(ω) 

 z = z0 + d . cos(ζ) 

 

Obr. 6 Schéma priestorovej polárnej metódy [11] 
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3.3 Princíp určenia vzdialenosti  

 V každom polárnom skeneri sa určuje dĺžka pomocou elektronického diaľkomeru. 

Elektronický diaľkomer je zariadenie, ktoré sa nachádza priamo v skenovacom systéme 

a skladá sa z dvoch častí: emitora a detektora. Emitor dokáže vyslať laserový lúč 

a detektor ho dokáže prijať po odraze od objektu (Obr. 7). Podľa princípu určovania dĺžky 

sa elektronické diaľkomery delia na impulzné a fázové. [8] 

Obr. 7 Schéma princípu elektronického diaľkomeru [8] 

 

Impulzné určovanie dĺžky: 

 Impulzný spôsob určovania dĺžky sa zakladá na meraní tranzitného času, ktorý 

elektromagnetický impulz potrebuje k prejdeniu dvojnásobku určovanej vzdialenosti. 

Emitor vyšle impulz, ktorý automaticky spustí elektronické meranie času. V momente, 

keď detektor príjme odrazený impulz, tak ukončí meranie času. Na základe známej 

rýchlosti impulzu prostredím a meraného tranzitného času je možné vypočítať 

dvojnásobok určovanej dĺžky.  

 K tomu je dôležité poznať index lomu prostredia, ktorý ovplyvňuje rýchlosť 

impulzu. Index lomu je funkciou vlnovej dĺžky impulzu, teploty, tlaku a vlhkosti 

prostredia. Taktiež je dôležité určiť tranzitný čas impulzu s veľmi vysokou presnosťou 

(až na 10-7 sekundy). Výhodou impulzného merania oproti fázovému je jeho väčší dosah 

pri meraní (stovky metrov). [8] 
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Fázové určovanie dĺžky: 

 Fázový spôsob určovania dĺžky funguje na princípe určenia fázového rozdielu, 

ktorý vzniká medzi vyslaným a prijímaným signálom. Vysielaný signál je nutné ešte 

predtým amplitúdovo modulovať. Emitor potom vyšle amplitúdovo modulovanú vlnu 

o známej fáze a po odraze od objektu ju detektor príjme s pozmenenou fázou. Nakoniec 

fázomer určí fázový rozdiel medzi vyslanou a prijatou vlnou.  

 Avšak výsledkom merania nie je absolútna vzdialenosť. Tá sa musí vypočítať 

súčtom nameraného fázového rozdielu a počtom celých vlnových dĺžok vysielaného 

elektromagnetického žiarenia. Nevýhodou fázového merania je jeho dosah, ktorý je 

obmedzený dĺžkou amplitúdovo modulovanej vlny (desiatky metrov). [8]  

 

3.4 Technické parametre polárnych skenovacích systémov  

 Medzi základné technické parametre polárnych skenerov patrí: 

 Zorné pole – V prípade polárnych skenerov je panoramatické a z toho dôvodu je 

možné skenovať do všetkých strán súčasne. V prípade potreby môže byť zorné 

pole vymedzené užívateľom na konkrétne smerové okno.  

 

 Dosah merania – Závisí na použitom type elektronického diaľkomeru a na 

odrazivosti (reflektivita) povrchu objektu, ktorý je skenovaný. Najlepšiu 

odrazivosť majú biele materiály s drsným povrchom, zatiaľ čo najhoršiu tmavé 

s hladkým povrchom.  

 

 Presnosť merania – Zvyčajne sa udáva ako presnosť jedného bodu na základe 

určenia vzdialenosti a uhlov pri meraní priestorovo polárnou metódou. Taktiež na 

ňu vplýva mnoho ďalších faktorov ako refrakcia prostredia, odrazivosť povrchu 

alebo uhol odrazu laserového lúču od objektu.   

 

 Rýchlosť skenovania – Definuje sa podľa počtu zameraných bodov za jednotku 

času. Tento parameter ovplyvňuje hlavne technologická konštrukcia prístroja. 

V súčasnosti majú polárne skenery veľmi vysokú rýchlosť skenovania v rádoch 

miliónov bodov za sekundu. [8] 
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4 Meranie v teréne 

 Meranie v podzemných priestoroch štôlne Josef prebiehalo hlavne v oblasti 

Mokrsko Západ. Okrem tejto oblasti bola zameraná aj časť prepojovacej chodby a časť 

oblasti Mokrsko Východ, ktorá bola prístupná. Celková dĺžka zameraných chodieb bola 

dokopy 1050 m a celkový čas potrebný na merania bol približne 11 hodín počas dvoch 

dní. Na skenovanie bol použitý prístroj Leica ScanStation P40, ktorý bol zapožičaný 

Fakultou Stavební.    

 

Informácie o meraní: 

Miesto merania:  Štôlňa Josef – Mokrsko Západ, Chotilsko, Příbram 

Dátum merania:  28. – 29.01.2021 

Atmosférické  

podmienky v podzemí: 11 °C, 980 hPa, 90 – 100 % vlhkosť vzduchu 

Pomôcky:   3D laserový skener Leica ScanStation P40, v. č. 1851583 

    2x statív 

    12x guľové terče 

    3x čiernobiele terče 

    Leica pásmo 

    trojnožka 

Meračská čata:  Ing. Tomáš Křemen, Ph.D. 

    Ing. Tomáš Jiříkovský, Ph.D. 

    Bc. Peter Petrilla 

 

Postup merania:  

  Pred začiatkom merania bola vykonaná rekognoskácia terénu, na základe ktorej 

sa určilo, že najlepšia poloha pre stanoviská prístroja bude v miestach, kde sa hlavná 

chodba Mokrska (kolmá na prepojovaciu chodbu) pravidelne rozráža do bočných strán. 

Z toho dôvodu boli stanoviská od seba vzdialené približne 25 až 30 m, vo výnimočných 

prípadoch bola táto vzdialenosť menšia.     
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 Samotné meranie skenovacím prístrojom začalo na západnom konci hlavnej 

chodby a postupovalo sa smerom na východ. Okrem hlavnej chodby boli zamerané aj 

niektoré bočné chodby, do ktorých sa bolo možné dostať. Taktiež bola zameraná aj 

prepojovacia chodba od križovatky spájajúcej západnú a východnú oblasť Mokrska až po 

jej koniec u vetracieho komína. 

 Na každom stanovisku bol postup merania rovnaký. Najprv boli okolo stanoviska 

rozmiestnené guľové terče vo vhodnej konfigurácii, kvôli transformácii nameraných dát. 

Taktiež sa rozmiestnili aj čiernobiele terče na existujúce body banského bodového poľa, 

ktoré sa nachádzalo v štôlni už pred meraním na túto diplomovú prácu. Následne bol na 

stanovisku postavený statív s trojnožkou, ktorý sa nahrubo zhorizontoval. Na trojnožku 

sa umiestnil skenovací prístroj, ktorý sa zhorizontoval najemno pomocou elektronickej 

libely. Ďalším krokom bolo nastavenie parametrov merania v prístroji a spustenie 

skenovania, ktoré bolo úplne autonómne. Výsledkom skenovania na stanovisku bolo 

mračno bodov. Po dokončení skenovania bolo ešte nutné v prístroji očíslovať všetky 

čiernobiele terče, ktoré boli viditeľné zo stanoviska. Nakoniec sa prístroj presunul na 

ďalšie stanovisko a proces sa zopakoval odznova. 

 Dokopy bolo vytvorených 49 stanovísk a na každom z nich bolo zamerané mračno 

bodov. Celkovo bolo získaných viac než 570 miliónov bodov. Poloha všetkých stanovísk 

a terčov v štôlni je zobrazená na dvoch mapách v nasledujúcej podkapitole (Obr. 9, 10). 

Umiestenie oboch máp v rámci oblasti Mokrsko je znázornené na obr. 8. 

 

Obr. 8 Mapa oblasti Mokrsko s vyznačením mapových rámov [4] [5] 
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4.1 Mapa merania v podzemných priestoroch 

  

Obr. 9 Mapa merania č. 1 
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Obr. 10 Mapa merania č. 2 
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4.2 Použitý skenovací prístroj 

 Použitý prístroj Leica ScanStation P40 (Obr. 11) patrí medzi 3D laserové skenery 

a pri určovaní vzdialenosti využíva kombinovaný impulzný a fázový diaľkomer. Jedná sa 

o polárny skener, ktorý bol pre potreby merania zapožičaný Fakultou Stavební spolu 

s ďalším vybavením. 

 

Technické parametre prístroja: 

Vlnová dĺžka laseru:  1550 nm (infračervené žiarenie), 658 nm (viditeľné svetlo) 

Dĺžková presnosť:   1,2 mm + 10 ppm 

Uhlová presnosť:   2,5 mgon – horizontálna, 2,5 mgon – vertikálna     

Presnosť 3D pozície:   3 mm na 50 m 

Dosah merania:  270 m 

Nastavená hustota bodov: 6,3 mm x 6,3 mm na 10 m 

Rýchlosť skenovania:  1 000 000 bodov za sekundu 

Zorné pole:   360° – horizontálne, 270° – vertikálne   

Hmotnosť:   12,25 kg 

Prevádzková teplota:  - 20 °C až + 50 °C [11] 

 

Obr. 11 3D laserový skener Leica ScanStation P40  
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4.3 Guľové a čiernobiele terče 

 Počas merania v štôlni bolo použitých 12 guľových terčov, ktoré slúžili ako 

vlícovacie (identické) body medzi susednými stanoviskami. Jednalo sa o biele plastové 

gule s priemerom 145 mm, ktoré mali drsný povrch kvôli lepšej odrazivosti laserového 

lúča pri skenovaní.  

 Pred začatím skenovania boli guľové terče umiestnené približne v polovičnej 

vzdialenosti medzi stanoviskom, kde malo prebiehať skenovanie a nasledujúcim 

stanoviskom. Bolo nutné, aby sa stále medzi nimi nachádzali aspoň dva guľové terče, 

s ktorými sa počas merania nesmelo pohnúť (Obr. 12). Až po skončení skenovania na 

oboch stanoviskách bolo možné terče presunúť na iné miesto. Dôvod tohto postupu bol 

ten, aby susedné mračná bodov obsahovali tie isté guľové terče. Tým pádom ich bolo 

možné transformovať do spoločného súradnicového systému.  

 

Obr. 12 Guľové terče umiestnené na počve štôlni 

 

 Taktiež boli pri meraní použité aj čiernobiele terče, ktoré sa umiestnili na 

existujúce body banského bodového poľa v štôlni. Tieto body boli stabilizované buď 

v počve alebo na strope štôlne. V prípade, že bol bod zabetónovaný v počve (č. bodu 

5XX), tak sa nad ním postavil statív s čiernobielym terčom (Obr. 13). Ak bol bod osadený 

v strope pomocou mosadzného hrotu (č. bodu 7XXX), tak bol terč iba nasunutý na hrot.  
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 Počas skenovania na stanovisku bolo dôležité, aby sa každý čiernobiely terč 

natočil smerom k prístroju a aby mu bolo priradené číslo bodu, na ktorom sa nachádza. 

V praxi to znamenalo, že stále keď prístroj skončil meranie na stanovisku, tak sa pomocou 

dotykovej obrazovky na prístroji vyhľadal naskenovaný terč a označil sa číslom bodu.  

 Čiernobiele terče neboli použité iba ako vlícovacie body medzi stanoviskami, ale 

aj ako pripojovacie body do súradnicového systému S-JTSK a výškového systému Bpv. 

Tieto terče boli dokopy umiestnené na deviatich bodoch banského bodového poľa. Avšak 

nie u všetkých bodoch sa dali dohľadať ich súradnice. Z toho dôvodu boli použité na 

pripojenie iba body: 524 (chodba SP – 71), 523 (chodba SP – 47) a 7907 (vetrací komín).  

 Na základe guľových a čiernobielych terčov použitých pri meraní bolo možné 

všetky naskenované mračná bodov spojiť a transformovať do systémov S-JTSK a Bpv. 

Celková výsledná presnosť tejto transformácie sa charakterizovala ako stredná absolútna 

chyba a jej hodnota bola 2,0 mm. Viac o priebehu transformácie je spomenuté v kapitole 

o spracovaní dát v softvéri Leica Cyclone. 

 

Tab. 1 Údaje o pripojovacích bodoch (S-JTSK, Bpv) 

 

Obr. 13 Čiernobiely terč na statíve na bode 524 

Číslo bodu Y [m] X [m] Z [m] Výška terča [m] 

524 753 975,496 1 079 963,290 297,565 1,317 

523 753 827,468 1 079 949,766 296,813 1,592 

7907 753 514,599 1 079 807,930 298,599 --- 
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5 Použitý softvér 

 Pri spracovaní nameraných dát bolo nutné použiť špeciálny softvér, ktorý 

umožňoval prácu s veľkým množstvom dát. Tým softvérom bol práve Leica Cyclone, 

ktorý pochádza od tej istej firmy ako použitý skenovací prístroj. Na dodatočné 

spracovanie dát bol použitý softvér MicroStation V8i spolu s nadstavbou DULMAP 19, 

v ktorom bola vytvorená účelová banská mapa. Všetky ostatné mapy a mapové schémy 

v tejto diplomovej práci boli vytvorené v softvéroch ArcGIS Pro a AutoCAD 2019.  

 

5.1 Leica Cyclone 

 Softvér Leica Cyclone bol vyvinutý firmou Leica Geosystems a používa sa pre 

vizualizáciu a spracovanie veľkých objemov dát získaných 3D laserovým skenovaním. 

Tento softvér je ideálnym nástrojom pre opravu chýb mračna bodov, odstránenie šumu 

alebo registráciu viacerých skenov. Okrem toho dokáže vytvárať z mračna bodov výstupy 

v podobe trojuholníkovej siete alebo drôtového modelu (CAD model), ktoré je možné 

ďalej spracovávať. Práca s ním je jednoduchá a intuitívna. Samotný softvér sa delí na 

viacero modulov, s ktorých každý má inú funkciu. Medzi najpoužívanejšie moduly 

softvéru patrí: 

 BASIC – Základný modul softvéru, ktorý slúži pre efektívnu správu skenovacích 

projektov a obsahuje základné geodetické funkcie (polygón, pretínanie späť). 

 

 REGISTER – Tento modul je kľúčovou časťou spracovania, pretože slúži na 

georeferencovanie dát skenovania do spoločného súradnicového systému na 

základe prekrytia mračien bodov alebo identických bodov.  

 

 MODEL – Jedná sa o modul pre vytváranie 3D modelov priamo z mračna bodov 

a ich ďalšiu úpravu vrátane ofarbovania fotografiami. K dispozícii má rozsiahlu 

knižnicu predpripravených strojárenských a priemyslových objektov. Výsledné 

3D modely dokáže exportovať do CAD programov.  
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 SURVEY – Tento modul je určený špeciálne pre geodetické úkony ako vytváranie 

rezov a profilov z 3D modelu alebo počítanie objemu a plôch. [12] 

 

5.2 MicroStation V8i 

 Softvér MicroStation V8i patrí medzi CAD programy a bol vyvinutý firmou 

Bentley Systems. Používa sa hlavne na modelovanie stavebných objektov, vytváranie 

mapových dokumentácii alebo na tvorbu grafického dizajnu. V rámci technických oborov 

sa využíva hlavne v architektúre a v geodézii. Jeho pracovné prostredie je založené na 

platforme dvoj alebo trojrozmerného priestoru, v ktorom je možné vytvárať a 

vizualizovať vektorovú kresbu.  

 

5.3 DULMAP 19 

 Softvér DULMAP 19 je nadstavbou na MicroStation V8i a vyvinula ho firma HSI 

špeciálne pre mapovanie banských diel. Jeho účelom je spracovanie geodetických údajov 

do podoby banskej mapovej dokumentácie, ktorá je v súlade s vyhláškou č. 435/1992 Sb. 

V samotnom softvéri sa nachádza veľké množstvo mapových značiek, ktoré spĺňajú 

všetky náležitosti spomenutej vyhlášky. Taktiež umožňuje vizualizovať rôzne typy 

účelových banských máp a prepájať ich medzi sebou podľa potreby užívateľa.  

 Licenciu na softvér DULMAP 19 poskytla firma HSI na vyžiadanie len pre 

spracovanie tejto diplomovej práce. Odkaz na webové stránky firmy HSI sa nachádza 

v bibliografii. [13]    
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6 Postup spracovania dát v softvéri Leica Cyclone 

 Spracovania nameraných dát v softvéri Leica Cyclone prebiehalo v niekoľkých 

etapách. Na začiatku bolo nutné nahrať dáta zo skenovacieho prístroja do softvéru 

a skontrolovať naskenované mračná bodov, či nie sú nejakým spôsobom poškodené. 

Následne sa každé z nich očistilo od šumu a nadbytočných bodov a boli im priradené 

identické body. V ďalšom kroku prebehlo spojenie (registrácia) všetkých mračien bodov 

do jedného celku, ktorý bolo možné vektorizovať a vytvoriť z neho použiteľný 3D model. 

Nakoniec sa výsledný model exportoval a ďalej sa spracoval v softvéri MicroStation V8i 

s nadstavbou DULMAP 19. 

 

6.1 Import nameraných dát 

 Všetky získané dáta v štôlni boli prenesené zo skenovacieho prístroja do počítača 

vo formáte *.imp a ich veľkosť bola približne 13 GB. Na ich prenos bol použitý externý 

pevný disk a boli importované do softvéru Leica Cyclone, v ktorom bola vytvorená nová 

databáza s názvom Mokrsko_zapad. Štruktúra tejto databázy sa skladala zo samostatných 

projektových súborov, ktoré sa jednotlivo označovali ako ScanWorld. V každom z nich 

sa nachádzalo práve jedno mračno bodov. Celá databáza obsahovala 56 projektových 

súborov, ale pri spracovaní sa použilo iba 49 z nich. Bolo to z dôvodu, že niektoré súbory 

obsahovali mračno bodov, ktoré buď nebolo panoramatické alebo bolo chybne zamerané. 

Samotný projektový súbor (ScanWorld) je tvorený dvoma hlavnými súbormi: 

 ControlSpace – Tento súbor obsahuje mračno bodov a všetky údaje 

o polohe terčov. Primárne slúži pri registrácii mračna bodov a tiež ako záloha 

surových dát. Za normálnych okolností užívateľ nemusí upravovať tento súbor. 

 

 ModelSpace – Taktiež obsahuje rovnaké mračno bodov ako ControlSpace, avšak 

primárne slúži na vizualizáciu, úpravu bodov a modelovanie geometrických 

prvkov (Obr. 14). Pri spracovaní je možné vytvoriť viacero kópií tohto súboru 

kopírovaním celého mračna bodov alebo len jeho časti. 
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Použité funkcie v softvéri: 

 Configure → Database → Add – Vytvorenie novej databázy 

 File → Import ScanStation Data → Import ScanStation Project – Import dát 

 

Obr. 14 Vizualizácia mračna bodov v ModelSpace 

 

6.2 Odstránenie nežiadúcich bodov 

 Počas merania skenovacím prístrojom v štôlni sa občas naskenovali aj body, ktoré 

boli chybné a neležali na mapovanom objekte. K tomuto javu dochádzalo z niekoľkých 

príčin. Väčšinou to bolo spôsobené tým, že sa do priestoru medzi prístroj a mapovaný 

objekt dostali napríklad osoby, vozidlá alebo prachové častice. Ďalšou príčinou, ktorá to 

spôsobovala, bol viacnásobný odraz laserového lúču v blízkosti ostrých hrán objektu. 

Prístroj v tom prípade zaznamenal nesprávnu vzdialenosť od bodu a vypočítal chybné 

súradnice. V oboch týchto sa jednalo o nežiadúce body v mračne bodov, ktoré bolo nutné 

odstrániť.  

 

Použité funkcie v softvéri: 

 Polygonal Fence Mode – Označenie nežiaducich bodov 

 Edit → Fence → Delete Inside – Vymazanie bodov 
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6.3 Vytvorenie vlícovacích bodov 

 Ďalším krokom pri spracovaní dát bolo vytvorenie vlícovacích bodov v každom 

mračne bodov. Tento krok bol nevyhnutný pre následnú registráciu dát. Ako vlícovacie 

body boli použité guľové terče, ktoré sa počas skenovania umiestňovali okolo stanoviska. 

Každé mračno bodov obsahovalo niekoľko naskenovaných guľových terčov, ktoré bolo 

nutné upraviť do použiteľnej podoby.  

 Na začiatku tohto kroku sa označili všetky body, ktoré boli naskenované na 

povrchu guľového terča. Pomocou funkcie Region Size sa upravila oblasť označených 

bodov podľa potreby užívateľa. Následne sa z týchto bodov vymodelovala guľa (Obr. 15) 

na základe metódy najmenších štvorcov a jej stred bol použitý ako vlícovací bod. 

Nakoniec sa pomocou funkcie Sphere Info skontroloval priemer vytvorenej gule, ktorý 

sa musel zhodovať z priemerom guľových terčov v teréne (145 mm). Celkovo bolo 

vytvorených 90 vlícovacích bodov rovnomerne rozmiestnených po celej mapovanej 

oblasti štôlne. 

 

Obr. 15 Proces modelovania sféry 

 

 Všetky vlícovacie body, ktoré boli vytvorené v predchádzajúcom kroku, bolo 

nutné označiť číslom kvôli registrácii (Obr. 16). Pre číslovanie týchto bodov sa zvolil 

interval od 101 do 190. Taktiež sa pri registrácii použili aj čiernobiele terče, ktoré slúžili 

ako vlícovacie a zároveň ako pripojovacie body. Tie nebolo nutné nijakým spôsobom 

upravovať alebo modelovať v mračne bodov, pretože boli označené číslom ešte počas 

merania v teréne.      
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Použité funkcie v softvéri:  

 Create Object → Region Grow → Sphere – Vymodelovanie gúľ 

 Tools → Registration → Add Label – Očíslovanie vlícovacích bodov 

 

Obr. 16 Očíslované vlícovacie body 

 

6.4 Registrácia 

 Počas spracovania dát v softvéri Leica Cyclone bol proces registrácie kľúčovým 

pre vytvorenie jedného homogénneho mračna bodov, v ktorom by každý bod mal známe 

súradnice v súradnicovom systéme S-JTSK (Systém jednotnej trigonometrickej siete 

katastrálnej) a zároveň vo výškovom systéme Bpv (Baltský systém po vyrovnaní).  

 Každé mračno bodov, ktoré bolo naskenované počas merania sa nachádzalo 

v miestnom súradnicovom systéme s počiatkom v stanovisku prístroja. Pri procese 

registrácie sa všetky mračná bodov spojili a georeferencovali pomocou vlícovacích 

a pripojovacích bodov. Výstupom z registrácie bolo spojené mračno bodov, ktoré bolo 

pripojené do systémov S-JTSK a Bpv. Základným princípom registrácie bola zhodnostná 

transformácia v priestore, pri ktorej sa jednotlivé mračná bodov posunuli (translácia) 

a pootočili (rotácia) o požadovanú hodnotu z miestneho súradnicového systému do 

spoločného. Na základe toho zostali zachované všetky vzdialenosti v rámci mračna bodov 

a nedošlo k jeho pretvoreniu (zmena veľkosti). 
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 Obecne platí, že pri zhodnostnej transformácii v priestore je nevyhnutné poznať 

súradnice aspoň troch identických bodov medzi susednými mračnami bodov. Avšak 

v tomto prípade stačili iba dva identické body. Dôvodom bolo to, že pri meraní na 

stanovisku bol skenovací pristroj stále zhorizontovaný. Tým pádom každé mračno bodov 

malo rovnaký smer vertikálnej osi vo svojom súradnicovom systéme (smer ťažnice). To 

viedlo k zjednodušeniu transformácie, pretože rotácia každého mračna prebiehala iba 

okolo vertikálnej osi. Z toho dôvodu nebol potrebný tretí identický bod medzi susednými 

mračnami bodov (Obr. 17).  

 Pred samotným procesom registrácie bola všetkým vlícovacím a pripojovacím 

bodom priradená váha, na základe ktorej sa výpočet transformácie mohol upravovať. 

Pripojovacím bodom bola priradená dvakrát väčšia váha (1) ako vlícovacím bodom (0,5). 

Presnosť výpočtu transformácie bola charakterizovaná ako stredná absolútna chyba, ktorá 

udávala aritmetický priemer zo všetkých rozdielov súradníc na identických bodoch. Jej 

výsledná hodnota bola 2,0 mm a protokol o výpočte transformácie bol pridaný do 

elektronických príloh.      

 

Obr. 17  Registrácia medzi susednými mračnami bodov 
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 Postup registrácie v softvéri začínal vytvorením nového projektového súboru 

(ScanWorld) v databáze Mokrsko_zapad, ktorý slúžil ako úložisko pre súradnice 

pripojovacích bodov. Do neho boli importované všetky súradnice vo formáte *.txt, ktoré 

sa nachádzali v systémoch S-JTSK a Bpv. Následne sa spustil registračný dialóg, do 

ktorého sa vložili všetky projektové súbory nachádzajúce sa v databáze. Súbor so 

súradnicami sa v tejto fáze nastavil ako fixný a počas registrácie sa s ním už nijakým 

spôsobom nemanipulovalo. Potom bolo možné zoskupiť jednotlivé súbory a načítať 

všetky spojenia na vlícovacích a pripojovacích bodoch medzi mračnami bodov. Tieto 

spojenia sa v softvéri označovali ako Constraints a bolo im možné priraďovať váhy podľa 

potreby užívateľa.  

 V ďalšom kroku sa spustila samotná registrácia a vypočítali sa chyby na všetkých 

použitých spojeniach (Constraints). V prípade, že niektorá z chýb bola príliš odľahlá od 

ostatných, bolo možné pozmeniť nastavenie váh a spustiť registráciu znova. Po skončení 

tohto kroku sa spustila dodatočná registrácia, ktorá prebiehala na základe prekrytia 

susedných mračien bodov. Na jej konci vzniklo spojené mračno bodov, ktoré sa 

skontrolovalo od prípadných chýb.    

 

Použité funkcie v softvéri:  

 Create → ScanWorld – Vytvorenie projektového súboru pre súradnice bodov  

 Import ASCII File Format – Import súradníc do projektového súboru  

 Create → Registration – Spustenie dialógu registrácie 

 Scan World → Add Scan World – Pridanie projektových súborov do registrácie 

 Control Scan World → Set Home ScanWorld – Nastavenie projektového súboru 

so súradnicami ako fixný počas registrácie 

 Create ScanWorld Groups – Zoskupenie všetkých projektových súborov dokopy 

 Constraints → Auto Add Constraints – Načítanie spojení na identických bodoch  

 Registration → Register – Výpočet absolútnych chýb na identických bodoch 

 Cloud Constraint → Auto Add Cloud Constraint – Dodatočná registrácia na 

základe prekrytia medzi mračnami bodov 

 Registration → Create ScanWorld / Freeze Registration – Zastavenie registrácie 

a vytvorenie spojeného mračna bodov (Obr. 18) 
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Obr. 18 Spojené mračno bodov 

 

6.5 Vektorizácia mračna bodov  

 V tomto kroku spracovania dát sa zo spojeného mračna bodov vytvoril výsledný 

3D model štôlne, ktorý už bolo možné exportovať zo softvéru. Podstatou tohto kroku bola 

vektorizácia, na základe ktorej sa mračno bodov nahradilo líniovými prvkami. Jednalo sa 

o manuálnu metódu spracovania, ktorá spočívala na princípe spájania línií na bodoch 

mračna. Týmto spôsobom sa vytvoril pôdorys štôlne a priečne rezy chodieb. Taktiež sa 

vo výslednom modeli vyznačila poloha technických zariadení a inžinierskych sietí štôlne. 

Všetky tieto prvky sa v softvéri rozdelili do jednotlivých vrstiev podľa ich účelu. 

Výsledkom tohto procesu bol drôtový 3D model (CAD model), ktorý sa exportoval zo 

softvéru vo formáte *.dxf.  

  

Vektorizácia pôdorysu štôlne: 

 Postup spracovania sa začínal vytvorením pôdorysu vo výške 1 m nad počvou 

štôlne. K tomu bolo nutné vyznačiť výškové stupne v mračne bodov, pomocou ktorých 

sa dali zakresľovať línie v konkrétnej výške. Z toho dôvodu sa farebné nastavenie mračna 

preplo do režimu výškovej mapy (Obr. 19), v ktorom sa striedali stupne po 20 cm. 

Následne sa pomocou funkcie Limit Box zobrazila iba spodná časť chodby bez stropu, 

aby bolo jednoduchšie vytvárať línie na vnútorných stranách stien. Nakoniec sa ručným 

označovaním bodov zakreslili línie na oboch stranách chodby.  
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Obr. 19 Mračno bodov v režime výškovej mapy 

 

 Týmto spôsobom sa vytvoril pôdorys vo všetkých chodbách, v ktorých prebiehalo 

meranie (Obr. 20). V prípade neprístupných chodieb Mokrska Západ sa pôdorys zakreslil 

odhadom na základe dostupných mapových schém, ktoré zhotovil URC Josef. [6]    

 

Obr. 20 Proces vytvárania pôdorysu 

 

Vektorizácia priečnych rezov chodieb: 

 Pri vytváraní priečnych rezov chodieb bolo nutné najprv označiť úzky pás mračna 

bodov v celej šírke chodby, ktorý sa následne skopíroval do samostatného súboru. V ňom 

sa body nahradili líniami po celom obvode priečneho rezu (Obr. 21). Po tomto kroku sa 

všetky body zo súboru odstránili a ostali v ňom iba línie. Následne sa vytvorená kresba 

pripojila naspäť do originálneho súboru. Celkovo bolo vytvorených 155 priečnych rezov 

po celej mapovanej oblasti štôlne v pravidelných rozostupoch po 10 m. Taktiež boli 

vyhotovené pri križovatkách chodieb alebo v miestach, kde sa nachádzali výstuže.   
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Obr. 21 Proces vytvárania priečneho rezu 

 

Vrstvy vektorovej kresby: 

 Celá vektorová kresba bola rozdelená do niekoľkých vrstiev, v ktorých sa 

nachádzali rozdielne typy prvkov: pôdorys, priečne rezy, steny, mreže, výstuže, 

elektrické rozvádzače, hasičské vybavenie, kamery, koľajnice, osvetlenie, spínače, 

telefóny, vzduchové potrubie, žľaby. 

 

Použité funkcie v softvéri:  

 Pôdorys: 

 View → Set Limit Box by Cursor – Vizualizácia menšieho objemu bodov 

 Edit Color Map → Elevation Map – Nastavenie režimu výškovej mapy  

 Create Object → From Pick Points → Line Segment – Vytvorenie 

líniových prvkov 

 

 Priečne rezy: 

 Polygonal Fence Mode – Označenie úzkeho pruhu bodov  

 Copy Fenced To New ModelSpace – Kopírovanie označených bodov do 

nového súboru 

 Create Object → From Pick Points → Line Segment – Vytvorenie 

líniových prvkov 

 Closing ModelSpace Viewer → Merge into original ModelSpace – 

Spojenie oboch súborov dokopy 
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7 Vytvorenie banskej mapovej dokumentácie 

 Vytvorenie banskej mapovej dokumentácie prebiehalo v softvéri DULMAP  

podľa predpisov vo vyhláške č. 435/1992 Sb. a výstupom bola účelová banská mapa na 

podklade základnej banskej mapy, ktorá sa vložila do príloh v papierovej a digitálnej 

forme.  

 

7.1 Spracovanie vektorovej kresby v softvéri DULMAP 

 Po skončení vektorizácie mračna bodov v softvéri Leica Cyclone sa musel 

vektorový model spracovať do podoby banskej mapy. Na tento účel poslúžil softvér 

DULMAP. Pred začatím spracovania sa najprv do softvéru pripojila zákazka s názvom 

UEF_Josef, ktorá bola výstupom diplomovej práce Ing. Ladislava Ritschela z roku 2020. 

V tejto zákazke sa nachádzali dáta zo všetkých meraní v štôlni Josef od roku 2016, ktoré 

boli získané metódou 3D laserového skenovania. Tieto dáta boli vizualizované v podobe 

digitálnej účelovej banskej mapy v oblasti Čelina (Obr. 22), ktorá bola rozdelená do troch 

poschodí podľa výšok (+0m, +20m, +40m). V tejto mape sa nachádzali údaje 

o rozmeroch podzemných chodieb, banskom bodovom poli, inžinierskych sieťach atď. 

Všetky tieto prvky boli rozdelené do niekoľkých výkresov podľa účelu a poschodia, 

v ktorom sa nachádzajú. [14] 

 

Obr. 22 Vektorová kresba oblasti Čelina [14] 
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 Celá zákazka UEF_Josef bola rozdelená do deviatich výkresov, ktoré boli vo 

formáte *.dgn a navzájom sa dali prepájať. Každý z týchto výkresov obsahoval niekoľko 

vrstiev, v ktorých boli uložené jednotlivé prvky podľa funkcie (Tab. 2). 

 

Rozdelenie zákazky podľa výkresov: 

 Důlní mapa +0m.dgn / +20m.dgn / +40m.dgn 

 Hlubina +0m.dgn / +20m.dgn / +40m.dgn 

 Inženýrske sítě +0m.dgn / +20m.dgn / +40m.dgn 

 

Tab. 2 Rozdelenie výkresov do vrstiev 

Výkresy Názvy vrstiev Popis 

Důlní mapa 

 

Body podrobné důlní Body banského bod. poľa na počve 

Hrany řezů – digitalizace Priečne rezy 

Odvodnění lomu Odvodňovacie priekopy 

Vlečky a trate Osa železničnej koľaje 

Objekty a místa zvl_význ_ El. rozvádzače, hasičské prístroje 

Větrání Vetracie potrubia, ventilátory 

Mříže zábradlí Mreže  

Hrany řezů přibližne Približný priebeh pôdorysu +1m  

Výstuže Výstuž – železná, murovaná 

Hrany řezů – šibíky Vodorovné rezy šachiet 

Hrany řezů +1m Pôdorys +1m 

Dveře a vstupní vrata Dvere, vráta 

Hrany řezů +1m výplň Plocha vytvorená s pôdorysu 

Body podrobné důlní - trny Body banského bod. poľa na strope 

Hlubina 

Hlubina Šachty a ich popis 

Hlubin_rub_prov_m_popis Vstupy do štôlne 

Hlub_rubání v prov_mapě Popis vstupov 

Inženýrske sítě  
Elektrické vedení Svetlá, spínače 

Sdělovací vedení Kamery, banský telefón 
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 Po pripojení zákazky UEF_Josef do softvéru DULMAP bolo možné prejsť 

k importu celého vektorového modelu mapovanej oblasti. Vektorový model sa do 

zákazky vložil spôsobom referenčného výkresu, ktorý bol vo formáte *.dxf. Celá zákazka 

sa nachádzala v systémoch S-JTSK a Bpv a z toho dôvodu sa mohol model jednoducho 

umiestniť podľa súradníc. Následne sa vektorová kresba upravila a očistila od všetkých 

chýb v líniách. Jednalo sa buď o nedokončenú kresbu v priečnych rezoch alebo duplicitné 

línie v pôdoryse. Ďalej bolo nutné priradiť všetky prvky modelu do jednotlivých 

výkresov. Prvky sa priraďovali iba do výkresov s označením +0m, pretože mapovanie 

prebiehalo iba na základnom poschodí štôlne. V každom výkrese sa prvky rozdelili do 

príslušných vrstiev podľa ich účelu, v ktorých boli vizualizované pomocou oficiálnych 

značiek banských máp. Dodatočne boli do výkresu pridané ďalšie prvky ako plochy 

pôdorysu a body banského bodového poľa.        

 Výsledkom tohto procesu bola digitálna účelová banská mapa na podklade 

základnej banskej mapy v oblasti Mokrsko Západ (Obr. 23), ktorá bola umiestnená 

v spoločnej zákazke s existujúcou mapou oblasti Čelina. Medzi týmito dvoma oblasťami 

neexistovalo napojenie vo vektorovej kresbe s dôvodu, že ich delila prepojovacia chodba, 

ktorá nebola zmapovaná. Export účelovej banskej mapy Mokrska Západ prebiehal 

v rámci kladov mapových listov Státní mapy v mierke 1:5 000 (SM 5). Taktiež sa zo 

softvéru exportovala aj nová zákazka s názvom UEF_Josef_2021, v ktorej sa nachádzala 

vektorová kresba oboch oblastí štôlne. Táto zákazka bola uložená do príloh v digitálnej 

forme spolu s knižnicou buniek a čiar použitých pri vytváraní kresby. 

 

Obr. 23 Vektorová kresba oblasti Mokrsko Západ 
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7.2 Banské predpisy 

 Všetky výsledné mapové výstupy v tejto diplomovej práci boli zhotovené v súlade 

s vyhláškou č. 435/1992 Sb. Českého báňského úřadu o důlně měřické dokumentaci při 

hornické činnosti a některých činnostech prováděných hornickým způsobem ve znění 

vyhlášky Českého báňského úřadu č. 158/1997 Sb., kterou se mění a doplňuje vyhláška 

Českého báňského úřadu č. 435/1992., o důlně měřické dokumentaci při hornické činnosti 

a některých činnostech prováděných hornickým způsobem.  

 Táto vyhláška upravuje vedenie, doplňovanie a uchovávanie banskej meračskej 

dokumentácie pre právnické a fyzické osoby pri banskej činnosti a činnosti vykonávanej 

banským spôsobom v zmysle zákona Českej národnej rady č. 61/1988 Sb., o banskej 

činnosti, výbušninách a o štátnej banskej správe, v znení zákona Českej národnej rady    

č. 542/1991 Sb. a pre organizácie, ktoré pre tieto účely vykonávajú projektové, 

výstavbové alebo iné práce.  

 Banská meračská a geologická dokumentácia musí zahŕňať hlavne údaje 

o ložisku, všetky banské diela, odvaly, výsypky a odkaliská ako aj povrchovú situáciu 

v rozsahu celého dobývacieho priestoru; ak je možné očakávať vzhľadom k úložným 

pomerom ložiska účinky dobývania aj mimo hranice dobývacieho priestoru, musí banská 

meračská dokumentácia obsahovať povrchovú situáciu aj v dosahu týchto účinkov. Ak 

sú banské diela alebo zariadenia umiestnená mimo dobývací priestor, musí dokumentácia 

zahrňovať aj táto diela alebo zariadenia. 

 Grafická časť banskej meračskej dokumentácie musí obsahovať: 

a) náčrty 

b) základnú banskú mapu 

c) profily a rezy 

d) mapu povrchu  

e) účelové banské mapy 

 

 Všetky práce spojené s tvorbou digitálnej dokumentácie musia byť 

prevádzkované s použitím softvéru, ktorého používanie sa riadi zvláštnymi predpismi 

(zákon č. 35/1965 Sb., v znení zákona č. 86/1996 Sb.). [15] 
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Základná banská mapa: 

 Základná banská mapa je technickým a právnym dokladom organizácie, vedeným 

pre banské činnosti a niektoré činnosti vykonávané banským spôsobom. Vyhotovuje sa 

trvalým spôsobom ako originál na základe údajov získaných vlastným meraním alebo na 

základe prevzatých údajov. Obsahom mapy sú zákresy všetkých základných banských, 

geologických a technických údajov a tiež údajov, ktoré sú nutné pre vedenie práce. 

Originál základnej banskej mapy sa vyhotovuje v mierke 1:500, 1:1000 alebo 1:2000, 

jednotne pre územie celého dobývacieho priestoru. Klad listov mapy nadväzuje na 

delenie evidenčnej jednotky (triangulačný list) v S-JTSK. [15]    

 Do základnej banskej mapy sa značkami zakresľujú: 

a) štvorcová sieť o rozmeroch 100 mm x 100 mm, prípadne iná súradnicová sieť 

b) štátne hranice a hranice katastrálnych území 

c) hranice chránených ložiskových území, chránených území a ochranných 

pásiem, dobývacích priestorov, ochranných pilierov, ochranných pásiem 

vrtov, prípadne iné obmedzenie činnosti 

d) základné a podrobné banské bodové pole 

e) prieskumné vrty, štôlne a šachty 

f) základné geologické údaje, plochy odpisov zásob ložiska 

g) banské a podzemné diela 

h) zariadenia a objekty slúžiace k bezpečnosti a ochrane zdravia pri práci 

a bezpečnosti prevádzky, vetrania a hasičskej ochrane 

i) údaje o predchádzajúcej banskej činnosti a ostatných činnostiach v podzemí 

j) údaje o objektoch a miestach zvláštnej dôležitosti 

k) úplná banská situácia v pásmu najmenej 100 m za hranicou dobývacieho 

priestoru  

l) línie profilov a rezov 

m) vrty a sondy 

n) správne, sociálne a technologické objekty a zariadenia 

o) krasové a iné dutiny prírodného charakteru 

p) odkaliská, odvaly, výsypky, skládky, úložiská odpadov a rekultivovanej 

plochy a ďalšie dôležité skutočnosti   
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 Medzi základné banské mapy možno zaradiť: 

a) základná prieskumná mapa pri vykonávaní geologicko-prieskumných prác na 

ložiskách nerastov na povrchu a pri geologickom a hydrologickom prieskume.  

b) základná banská mapa pri hlbinnom dobývaní nerastov 

c) základná mapa lomu pri povrchovom dobývaní nerastov 

d) základná mapa pri ťažbe ropy a zemného plynu sondami 

e) základná mapa pri ťažbe lúhovaním sondami 

f) základná mapa vykonávaných prác na povrchu pri činnostiach vykonávaných 

banským spôsobom podľa zákona Českej národnej rady č. 61/1988 Sb., 

v znení zákona Českej národnej rady č. 542/1991 Sb. 

g) základná mapa zvláštnych zásahov do zemskej kôry   

 

Mapa povrchu: 

 Mapa povrchu sa vedie podľa zvláštnych predpisov zákona č. 200/1994 Sb. na 

podklade pozemkovej mapy evidencie nehnuteľností. Mapa povrchu sa vedie v mierke 

základnej banskej mapy. Ak nedôjde k zhoršeniu čitateľnosti a prehľadnosti, môže byť 

mapa povrchu použitá ako podkladová mapa pre základnú mapa vykonaných prác pri 

niektorých činnostiach vykonávaných banským spôsobom. V prípade, že je mapa vedená 

digitálnou formou, je možné využiť ako vektorového tak rastrového zobrazenia. [15]    

 

Účelová banská mapa: 

 Účelové banské mapy vedené digitálnou formou, majú svoj základ v digitálnej 

základnej banskej mape a sú tvorené odoberaním, doplňovaním, poprípade úpravou 

vrstiev grafického systému. Vedenie účelových banských máp sa riadi smernicou 

spracovanou hlavným banským meračom a schválenou vedúcim pracovníkom 

organizácie. [15]    

 Medzi účelové banské mapy patria: 

a) prevádzková banská mapa 

b) mapa vetrania 

c) mapa zdolávania havárií 

d) základná mapa závodu 
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7.3 Značenie v banských mapách 

 Značenie použité vo výslednej účelovej banskej mape bolo v súlade s vyhláškou 

č. 435/1992 Sb. (Obr. 24). Všetky značky farebne odpovedali materiálom podľa tab. 3 

a boli rozdelené do troch skupín. Prvú skupinu tvorili značky základných banských máp, 

ktoré popisovali rozmery chodieb, polohu bodov banského bodového poľa a dôležité 

zariadenia v štôlni. V druhej skupine sa nachádzali značky účelových banských máp, 

ktoré popisovali hlavne technické zariadenia a inžinierske siete. Poslednú skupinu tvorili 

značky, ktoré sa nenachádzali priamo vo vyhláške. Tie boli buď vytvorené podľa 

vyhlášky v bakalárskej práci Ing. Gertrúdy Paštékovej (dvere, kamera) alebo sa prebrali 

zo softvéru DULMAP, kde boli nadefinované. [16] 

 

Obr. 24 Použité značky vo výslednej mapovej dokumentácii 
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Druh materiálu Farba Označenie 

Drevo žltá T3 

Tehlový múr, 

plynosilikátové tvárnice 
červená T5 

Betón, betónové tvárnice zelená T15 

Železo modrá T12 

Sadra modrá T10 

Popolček, íl žltá T2 

Voda modrá T12 

Plyn žltá T3 

Vzduch (úžitkový) zelená T29 

Tab. 3 Farebné vyznačenie materiálov 

 

7.4 Výsledná banská dokumentácia  

 Výslednou banskou dokumentáciou bola účelová banská mapa na podklade 

základnej banskej mapy v oblasti Mokrsko Západ. Táto mapa musela byť rozdelená na 

štyri mapové výstupy, aby pokrývala celú mapovanú oblasť. Tieto mapové výstupy boli 

vyhotovené na základe kladu mapových listov Státní mapy v mierke 1:5 000 (SM 5). 

Taktiež sa vyhotovila aj mapa s obecným výrezom pre celú oblasť Mokrska Západ.  

 Počas exportu zo softvéru DULMAP sa pre každú mapu vygeneroval mapový 

rám, do ktorého sa vložila kresba mapy pomocou referenčného výkresu. Následne sa do 

mapy ručne pridal popis mapového listu a legenda použitých značiek. Po dokončení 

exportu sa všetky mapové výstupy vložili do príloh v papierovej a v digitálnej podobe vo 

formátoch *.pdf a *.dgn. 

 

Tab. 4 Rozdelenie mapových výstupov 

Formát 

mapy 
Názov mapového výstupu Mapový list SM 5 Mierka 

A1 

UDM_Dobris_1-9_344 Dobříš 1-9/344   

1:500 
UDM_Dobris_1-9_433 Dobříš 1-9/433 

UDM_Krasna_Hora_1-0_122 Krásna Hora 1-0/122 

UDM_Krasna_Hora_1-0_211 Krásna Hora 1-0/211 

UDM_Obecny_Vyrez - - - 1:1000 
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Záver 

 Cieľom tejto diplomovej práce bolo zmapovanie chodieb štôlne Josef v oblasti 

Mokrsko Západ a vytvorenie banskej mapovej dokumentácie. Do mapovanej oblasti bol 

pridaný aj úsek prepojovacej chodby a časť Mokrska Východ. Meranie v teréne 

prebiehalo pomocou 3D laserového skeneru Leica ScanStation P40 a celkovo bolo 

vytvorených 49 stanovísk, na ktorých sa zameralo mračno bodov. Dokopy bolo 

zameraných 1 050 m podzemných chodieb a získaných okolo pol miliardy bodov.   

 Spracovanie takého veľkého množstva dát si vyžadovalo špecializovaný softvér 

s názvom Leica Cyclone, v ktorom sa všetky dáta spojili a pripojili do systémov S-JTSK 

a Bpv. Presnosť registrácie bola charakterizovaná strednou absolútnou chybou, ktorá 

mala hodnotu 2,0 mm a bola postačujúca pre pokračovanie v spracovaní. Zo spojeného 

mračna bodov bol vytvorený drôtový 3D model, ktorý zachytával rozmery chodieb 

a polohu zariadení v štôlni.  

 V ďalšom kroku bolo nutné použiť pri spracovaní dát existujúcu mapovú 

dokumentáciu štôlne Josef. Pre tento účel bola využitá diplomová práca Ing. Ladislava 

Ritschela, v ktorej boli zjednotené všetky merania od roku 2016 do roku 2020. Jednalo 

sa o dáta z 3D laserového skenovania v oblasti Čelina, ktoré boli vizualizované do podoby 

digitálnej účelovej banskej mapy v softvéri DULMAP. V tomto softvéri sa spojila 

existujúca mapa s vytvoreným 3D modelom, ktorému bolo priradené značenie podľa 

vyhlášky 435/1992 Sb. Českého báňského úřadu o důlně měřické dokumentaci při 

hornické činnosti a některých činnostech prováděných hornickým způsobem. Výsledkom 

tohto procesu bolo vyhotovenie účelovej banskej mapy na podklade základnej banskej 

mapy oblasti Mokrska Západ.    

 Do digitálnych príloh sa vložili všetky súbory, ktoré by mohli byť potrebné pri 

budúcom mapovaní štôlne Josef. Jedná sa hlavne o zákazku UEF_Josef_2021 zo softvéru 

DULMAP, do ktorej je možné stále pridávať nové merania z terénu. Medzi nezmapované 

oblasti, ktoré by mohli byť objektom ďalších záverečných prác, stále patrí prepojovacia 

chodba medzi Čelinou a Mokrskom a taktiež aj oblasť Mokrska Východ, ktorá je zatiaľ 

neprístupná z bezpečnostných dôvodov.     
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